
Career & Technical Education 
Technical Incentive Grants
Frequently Asked Questions

GENERAL
· What is the purpose of the CTE Technical Incentive Grants?

· How much is available from the CTE Technical Incentive Grants?

· Who is eligible to receive the CTE Technical Incentive Grant funds?

· Who receives the funds from the CTE Technical Incentive Grants?

· What certificates are eligible for the CTE Technical Incentive Grants?
· How can my school district begin offering CTE programs that lead to state-approved industry-recognized certifications? 

· Are private, voucher, or 2r Charter Schools included in this Act?
· How were the certifications chosen that appear on the approved 2014 CTE Technical Incentive Grant Certifications list?

· Why isn’t XYZ certification on this list?  How will the approved certification list change?  Can we get XYZ certification added to the list?  What if ABC certification gets removed?  

APPLY
· How do we claim the funds? 

· When can I apply for the CTE Technical Incentive Grant funds?
· How do I complete the application form for the CTE Technical Incentive Grant funds? 
· How do I insert my district administrator’s electronic signature?  

· What if I do not have a DEVELOPER tab in EXCEL to use the MACRO button?
· What are the Wisconsin Technical College Certificates?  

· Do dual credit classes from our local technical college count as “Wisconsin Technical College Certificates”?

· How do I submit the application form for the CTE Technical Incentive Grant funds?

· What is Accellion?

· How do I get an Accellion login?
· Why do I submit the applications to DPI not DWD?
DOCUMENTATION
· What documentation is required in addition to the application form?
· What if I can’t obtain the documentation from the student (graduated, lost, etc.)?
· What if I can’t obtain the documentation from the certifying agency?
· Why do some certifications require documentation while others do not?
VERIFICATION
· What does DWD and DPI review for verification? 

· How long will it take DWD and DPI to verify the applications?

· Why does it take so long to complete the verification process?
· Will I be contacted during the verification process? 

· What will happen if a certification or student is found to be ineligible? 

SPENDING
· How much funding is available?

· How will the grant funds be received at my school district?
· How can I spend the CTE Technical Incentive Grant funds?
· Do I need to submit claims for purchases with the CTE Technical Incentive Grant funds?
· What is the timeframe for spending the CTE Technical Incentive Grant funds?
· How do I explain/code the CTE Technical Incentive Grant funds in a school district financial audit?
GENERAL

· What is the purpose of the CTE Technical Incentive Grants?

The intent of the legislation is to support and strengthen quality CTE programming that results in industry-recognized certifications that help to mitigate workforce shortages.  There are a number of certification programs available locally and nationally.  However, the ones listed on the approved CTE Technical Incentive Grant Certifications list include rigorous and valid certification programs that have value in an employer setting.  

· How much funding is available from the CTE Technical Incentive Grants?

There is a maximum of $3 million total currently allocated for the CTE Technical Incentive Grants.  Funding is limited to $1000 per pupil regardless of the number of certifications the student has earned on the approved CTE Technical Incentive Grant Certifications list.  If more than 3000 high school graduates are claimed, then this will result in pro-rating the allocated $3 million funding accordingly.  

· Who is eligible to receive the CTE Technical Incentive Grant funds?

This incentive grant funding is available to Wisconsin public school districts.  School districts may apply for funds for each pupil that earns a regular high school diploma or technical education high school diploma AND a certification from the approved CTE Technical Incentive Grant Certifications list. 

· Who receives the funds from the CTE Technical Incentive Grants?

The funding is allocated to the school district, not to the student.  The intent of the funding is to support schools to provide and strengthen quality CTE programming that results in industry-recognized certifications that help to mitigate workforce shortages.  
· What certificates are eligible for the CTE Technical Incentive Grants?

Certificates eligible for the CTE Technical Incentive Grants fall into four categories:  

1. State Certified Work-Based Learning Programs- DWD Youth Apprenticeship (YA),
2. State Certified Work-Based Learning Programs- DPI Cooperative Education Skill Standards (Skills Co-Op), 

3. Business & Industry Recognized Certifications, and 
4. Wisconsin Technical College Credentials 
See the current approved CTE Technical Incentive Grant Certifications list for the specific certifications eligible.
· How can my school district begin offering CTE programs that lead to state-approved industry-recognized certifications? 

DPI suggests that you start with examining your current CTE courses to determine if there is an opportunity to enhance programming by aligning and offering any of the certifications listed.  One type of program that is well established and offers flexibility in how students may demonstrate proficiency of competencies includes the State of Wisconsin Work-based Learning Certifications.  These certifications include: State Certified Cooperative Education Skill Standards Programs (DPI) or Youth Apprenticeship (DWD).

· Are private, voucher, or 2r Charter Schools included in this Act?

No. This incentive grant funding is available to Wisconsin public school districts.

· How were the certifications chosen that appear on the approved 2014 CTE Technical Incentive Grant Certifications list?

Multiple factors and considerations were used to compile the approved CTE Technical Incentive Grant Certifications list. DWD and DPI staff reviewed a comprehensive list of both national and state certifications in the six career and technical education content areas; Agriculture and Natural Resources, Business and IT, Family and Consumer Science, Marketing and Entrepreneurship, Health Science, and Technology and Engineering which align with the 15 Career Clusters indicated as experiencing workforce shortages.  The following guidelines were considered for placement on this listing.

· Certifying Agency

· Is the certifying agency nationally recognized within the industry sector?

· Is the certifying agency accredited if it is an educational institution?

· Is the certifying agency a Wisconsin state agency?
 

· Certification Validity

· Is the certification endorsed by multiple companies within the industry sector?

· Is a person with this certification considered more “desirable” or “hirable” by companies within the industry sector?

· Is the certification recognition transferable to another company within the industry sector?
 

· Certification Program

· Is training and certification eligibility accessible by high school students?

· Is the certifying program comprehensive and rigorous enough to provide for technical skill practice and attainment?

· Does the certification training target only one occupational task?

· Were the certification requirements, training, and skill assessments reviewed, validated, and/or endorsed by industry sector representatives?

· Does the certification provide entrance into further education and training if desired by the student?

This list will be reviewed at least bi-annually and modified in response to labor market information and emerging certifications.

· Why isn’t XYZ certification on this list?  How will the approved certification list change?  Can we get XYZ certification added to the list?  What if ABC certification gets removed?  

DWD has a process in place to review and consider additional certifications for placement on the approved CTE Technical Incentive Grant Certifications list.  This list will be reviewed at least bi-annually and modified in response to labor market information and emerging certifications.  Certifications currently listed will not be removed without appropriate notification in order to accommodate students currently earning those certifications.  
APPLY

· How do we claim the funds? 

1. Obtain documentation proof of the completed student certifications as indicated on the current approved CTE Technical Incentive Certifications list.

2. Attend or view the recorded webinar prior to completing the claim form.  See https://dwd.wisconsin.gov/det/cteincentive/. 
3. Complete the appropriate application form for the correct claim year, as the form may have changed.  See http://dpi.wi.gov/cte/technical-incentive. 
4. Submit the application and documentation via Accellion to DPI as indicated on the claim form ‘Directions’ tab.

· When can I apply for the CTE Technical Incentive Grant funds?

Applications will become available prior to the current year’s graduation.  In general, they will be due on September 30 of each calendar year.
· How do I complete the application form for the CTE Technical Incentive Grant funds? 
1. Attend or view the recorded webinar prior to completing the claim form.  See https://dwd.wisconsin.gov/det/cteincentive/. 

2. Follow the information under the ‘Directions’ tab on the claim form.  

3. Complete the appropriate application form for the correct claim year, as the form may have changed.  See http://dpi.wi.gov/cte/technical-incentive. 
Contact Denise Byrd at Denise.Byrd@dpi.wi.gov or at (608) 267-2274 for any questions regarding completion of the claim form or submission via Accellion.
· How do I insert my district administrator’s electronic signature?  
1. Obtain the District Administrator’s signature on a piece of paper.
2. Scan the signature paper into a pdf format.

3. Using the Microsoft (MS) Snipit Tool or other Image editing program, such as MS Paint, crop the area around the signature.

4. Save the signature image in a jpg, bmp, or png format and note the file location.

5. Click Developer tab; Click “Macros,” Click “Insert_Signature.”

6. A window will open and ask you to find the file to insert.  Once you open the file, it will automatically insert the signature in the box and resize it.

7. Submit the completed EXCEL claim form and supporting documentation via Accellion.
OR

1. Sign a printed copy of the claim form.

2. Scan the signed claim form as a pdf.

3. Submit BOTH the completed unsigned EXCEL claim form, the signed pdf form, and supporting documentation via Accellion.
· What if I do not have a DEVELOPER tab in EXCEL to use the MACRO button?

If you do not see the Developer Tab at the top of the EXCEL claim form, then you will need to activate it using the following instructions.

Newer Excel Version.
1. Click on the round “Office Button” on the top left of the window. 
2. Select “Excel Options” at the bottom of the menu list.

3. Under “Popular,” click the 3rd check box to “Show Developer Tab.” Click “Okay.”

4. The Developer Tab will then appear on your document.    

Older Excel Version.
1. Click on the File tab. 
2. Select Customize. 
3. Scroll until you locate the Developer Tab option to add to your document. 
4. Check the box and click “Okay”. 
5. The Developer Tab will then appear on your document. 
Contact Denise Byrd at Denise.Byrd@dpi.wi.gov or at (608) 267-2274 if you have any questions.

· What are the Wisconsin Technical College Certificates?  

Each college in the Wisconsin Technical College System offers a number of different types of credentials that range from certificates to diplomas to degrees.  The ones eligible for the approved CTE Technical Incentive Grants list will have a state-approved PROGRAM number beginning with 10-, 30-, 31, or 61-.  A state-approved program number indicates that the combination of courses in the certificate, diploma, or degree program have been reviewed and determined to constitute a set of ‘hirable’ skills that are supported by local region labor market information.     
· Do dual credit classes from our local technical college count as “Wisconsin Technical College Certificates”?

Dual Credit classes taken at the high school and/or technical college are an important part of a student’s Academic and Career Planning, allowing students to experience the rigor and benefit of college level coursework.  However, taking Dual Credit courses alone ARE NOT necessarily eligible for this funding.  To be eligible, the dual credit courses MUST be part of an embedded technical diploma (ETD), career pathways certificate (CPC), regular technical diploma (TD) or applied associate degree (AAS).
· How do I submit the application form for the CTE Technical Incentive Grant funds?

1. Click “Developer,” “Macros” 

2. Select “File_Save_As,” Click RUN
3. Login into the Accellion web interface using your email address and Accellion password at https://moveit.dpi.wi.gov/courier/web/1000@/wmLogin.html. 

a. If your district has integrated Accellion with its directory services, you can login using your email address and network password.

b. If you do NOT have Accellion account, click “I don’t have an account yet” on the Login page.  Enter your email address.  Check your email for the registration verification.  Click the link in the email.  You will be taken to the login screen where you will be prompted to create a new password.  The temporary password is only active for 7 days.

4. Upload your Claim Form and supporting documentation from the saved location.

5. Contact Denise Byrd at Denise.Byrd@dpi.wi.gov or at (608) 267-2274 if you have any questions.

· What is Accellion?

Accellion is DPI’s secure file transfer protocol software that allows schools to upload student information on the claim form.  The secure transfer is necessary to protect the Personal Identifying Information (PII) of the individually assigned Wisconsin Student Number or WISEid entered on the claim form.  This number is needed to match school data to confirm graduation.

· How do I get an Accellion password?

1. Login into the Accellion web interface at https://moveit.dpi.wi.gov/courier/web/1000@/wmLogin.html. 

2. Click “I don’t have an account yet” on the Login page.  
3. Enter your email address.  
4. Check your email for the registration verification.  Click the link in the email.  You will be taken to the login screen where you will be prompted to create a new password.  The temporary password is only active for 7 days.
5. Contact Denise Byrd at Denise.Byrd@dpi.wi.gov or at (608) 267-2274 if you have any questions.

· Why do I submit the applications to DPI not DWD?

DPI hosts the secure file transfer protocol software, Accellion, necessary to protect the Personal Identifying Information (PII) of the individually assigned Wisconsin Student Number or WISEid entered on the claim form.  This number is needed to match school data to confirm graduation.

DOCUMENTATION

· What documentation is required in addition to the application form?

See the current approved CTE Technical Incentive Grants list for the certification documentation proof required.  It is listed in the last column of the list.
· What if I can’t obtain the documentation from the student (graduated, lost, etc.)?

You will need to contact the certifying agency to obtain a duplicate copy of the required certification.  In some cases, the student will have to do this for privacy reasons.  DPI and DWD cannot process a claim without the required documentation.
· What if I can’t obtain the documentation from the certifying agency?

In some cases, the student may have to make the request for the documentation directly from the certifying agency for privacy reasons.  DPI and DWD cannot process a claim without the required documentation.

· Why do some certifications require documentation while others do not?

DPI and DWD manage and maintain the certification list databases and documentation proof for the following programs:  DPI Cooperative Education Skill Standards (Skills Co-op), DWD Youth Apprenticeship (YA), Assistant Child Care Teacher (ACCT), and Infant Toddler (IT).  Therefore, we do not need to collect additional copies.
VERIFICATION

· What does DWD and DPI review for verification? 

1. DPI verifies-

· Claim form completion and supporting documentation receipt,  

· DPI Cooperative Education Skill Standards (Skills Co-op), Assistant Child Care Teacher (ACCT), and Infant Toddler (IT) completions, and
· Graduation completion for claim year.
2. DWD verifies-

· Youth Apprenticeship (YA) completions,

· Remaining business and industry certification documentation, other than ACCT and IT, and 

· WTCS program approvals and completions.  
· How long will it take DWD and DPI to verify the applications?

Verifications are generally complete by April 15 in the following calendar year.
· Why does it take so long to complete the verification process?
Graduation data received from the school districts via their different Student Information Systems (SIS) is not considered certified until that time.  Furthermore, it is time intensive to verify each submitted piece of documentation with the claim form.
· Will I be contacted during the verification process?
If there are questions regarding the supporting documentation, you may be contacted by DWD to provide additional clarification or appropriate documentation.
· What will happen if a certification or student is found to be ineligible? 

Each year in May, after the verifications are complete, each District Administrator and claim form submitter will be sent a “last chance” email listing the students found to be ineligible along with the reason for the disqualification.  The school district will then have approximately 7-14 days to follow up with DPI regarding any discrepancies.
SPENDING

· How much funding is available from the CTE Technical Incentive Grants?

There is a maximum of $3 million total currently allocated for the CTE Technical Incentive Grants.  Funding is limited to $1000 per pupil regardless of the number of certifications the student has earned on the approved CTE Technical Incentive Grant Certifications list.  If more than 3000 high school graduates are claimed, then this will result in prorating the allocated $3 million funding accordingly.  

· How will the grant funds be received at my school district?

After pro-rating is completed, the funds will be distributed electronically directly from DPI.  Please see our website at http://dpi.wi.gov/cte/technical-incentive for current account coding.
· How can I spend the CTE Technical Incentive Grant funds?

There are no restrictions on how the funding may be spent; however the legislation and incentive grant award is intended for schools to provide and strengthen quality CTE programming that results in approved certifications that mitigate workforce shortages.

· Do I need to submit claims for purchases with the CTE Technical Incentive Grant funds?

No.  The CTE Technical Incentive Grant funds are not cost reimbursement grants, therefore no spending claims or submissions need to be sent to DPI.
· What is the timeframe for spending the CTE Technical Incentive Grant funds?

The CTE Technical Incentive Grant funds are not cost reimbursement grants, therefore, the funds can be carried over into different fiscal years.
· How do I explain/code the CTE Technical Incentive Grant funds in a school district financial audit?
Please see our website at http://dpi.wi.gov/cte/technical-incentive for current account coding.  You may contact DPI’s CPA at (608) 264-9331 for specific questions regarding financial auditing. 


